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COURSE INFORMATION  
Course title:  Customer Analytics 
Course code:  BAMA 520 - 011  Credits:  2 
Session and term:  2024W1  Class location:  Angus 437 
Section(s):  001 Class times:  M/W 10-12pm PST 
Course duration:  Sep 4 – Oct 4 Pre-requisites:  n/a  
Division:  MBS  Co-requisites:  n/a 
INSTRUCTOR INFORMATION  
Instructor:  Yanwen Wang  
Phone:  604-827-0078  Office location:  HA 570 
Email:  Yanwen.wang@sauder.ubc.ca  Office hours:  by appointment 
  
COURSE DESCRIPTION  

Traditionally, marketers have focused on the acquisition of new customers through mass advertising and 

price-oriented promotions, accepting as a fact of life that newly acquired customers would eventually 

switch to competitors. Today, the focus has changed from customer acquisition to customer development 

and retention, particularly for the firm’s best customers. This shift from customer acquisition to 

development and retention requires a new mindset from product-centric to customer-centric 

management and raises new questions. For instance, what is the maximum amount a firm should spend 

to acquire a customer? Should firms want to keep their customers forever? What can be learned from 

customer defection?  

New forms of information technology provide increasingly rich data of individual-level customer behavior 

to address these issues but few firms have the expertise to intelligently act on such information. This 

course will provide students with the analytical tools that are necessary for understanding and predicting 

customer behavior and assessing customer lifetime value. The course will be grounded in relevant 

academic work as well as cases and exercises covering a broad set of industries and applications. 

You will develop a deep understanding of customer centricity and its implications for the firm, learn 
about state-of-the-art methods for calculating customer lifetime value and customer equity, and 
develop the analytical and empirical skills that are needed to judge the appropriateness, performance, 
and value of different statistical techniques that can be used to address issues around customer 
acquisition, development, and retention. 
 
COURSE FORMAT  
Class time will be used for a combination of lectures, discussion, solving sample problems, and case 

discussions. Attendance is expected to accomplish the learning objectives below. Lectures and 

discussions will assume that students having pre-read the corresponding case studies as listed in the 

course schedule below. 

LEARNING OBJECTIVES  
By the end of this course, students will be able to: 

1. Understand the importance of customer-centric valuation 
2. Link customer satisfaction, loyalty program, and recommendation system with the broad concept of 

customer relationship management 
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3. Apply key customer value analytics tools to a real customer database 
4. Recommend strategies based on customer relationship analytics 
 
SUSTAINABLE DEVELOPMENT GOALS (SDGS) 
At UBC Sauder, we are committed to responsible business practices that can have transformative 
impacts on society. One of the ways we are reinforcing our commitment to responsible business is by 
showcasing relevant content in our courses via the lens of the United Nations Sustainable Development 
Goals. In this course, we will touch on topics that relate to the following goals:  
 
 
Sustainable Development Goal  Description of how and when the goal is covered in the course. 

 
Goal 9: Industry, Innovation 

and Infrastructure 

 

 

 

In week 3, we will have one full class dedecated to how GPT presents 
opportunities and challenges in data analysis and problem solving.  

 

Goal 10: Reduced Inequality 

 

In week 5, we will have reading, lecture content, and group 
discussions on how segmentation can treat consumers differentially 
based on various demographic differences, which can impact 
consumers’ access to different products and services.  

 

 
ASSESSMENTS  
Summary  
Component  Weight  
Individual Assignments  15%  
Group Assignments  50%  
Class participation     15%  
Final Exam     20% 
Total  100%  
  
Details of Assessments  
 Individual Assignments (10%+5%) 
There are three individual assignment during the term. The objective is to help you gain a better 
understanding of the skills taught in class. 
 
Group Assignments (10%*5 ) 
Each group has 5 team members. You will stay in the same team for all the group assignments. If you want 
to choose team member and form your own team, please form your teams on Canvas under the “People 
- > Group Assignment” sector by midnight Sep 3 2024. If you do not form a team by then, I will randomly 
assign you to a group and reveal group formation information in class on Sep 4 2024.  

https://sdgs.un.org/goals
https://sdgs.un.org/goals
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Please answer all the questions for each group case. The objective is to help you learn data analysis skills 
through practice and from each other. Group assignments must be prepared individually for each group. 
Sharing work across groups is strictly prohibited in line with the RHL Academic Misconduct Regulations. 
Peer evaluations will be conducted at the end of semester. 
 
Peer evaluations will be completed at the end of the term to provide feedback on how team members 

think each member (including their own) is contributing to the group project. Individual grades on group 

assignments may be subject to adjustment following my review of peer evaluations. Reductions can be 

significant, ranging from a decrease of 10% to a decrease of 100% if an individual has contributed little 

or nothing to the team’s work.  In most instances, where team members are reliable and contribute, no 

adjustments are made.  

Students are required to complete peer evaluations by the specified deadline (announced before the 

end of the class). Failure to complete the evaluation will result in a 10% reduction in the mark received 

for the group assignment portion of this course (for example if you got 50 out of 50 on the group 

assignment score and did not complete peer evaluations your total group score will be adjusted to 45). 

Please ensure that you complete the peer evaluations on time. 

 

Class Participation (15%) 

We will devote a significant portion of class time to solving practice problems and cases. In order to 

maximize the benefits to you, it is of utmost importance that you be prepared to discuss the materials 

during class. For effective class participation includes: 

- (1) complete all the class activity on time 
-  (3) install all the software prior to the in-class lab sessions,  
- (4) ask questions about concepts related to class or lecture contents,  
- (5) share your experience or point of view with the class,   

Note that attending class and not speaking has neither a positive nor a negative impact on your 

participation score.  

Final Exam (20%) 

The final exam will be a computer-based multiple choice exam. Details to be reviewed in class. 

 

LEARNING MATERIALS  
Course pack 

There is no required textbook for this course. Instead, we will use a combination of cases and articles 

for readings. All the class materials can be accessed from Canvas or through purchase (see Course Pack 

info below). 

1. Go to the Ivey Publishing website at www.iveypublishing.ca 

2. Log in to your existing account or click "Register" to create a new account and follow the prompts to 

complete the registration. If registering, choose the "Student" role. 

https://www.iveypublishing.ca/
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3. Click on this link or copy into your browser: https://www.iveypublishing.ca/s/ivey-

coursepack/a1R5c00000FvZroEAF 

4. Click "Add to Cart". 

5. Go to the Shopping Cart (located at the top of the page), click "Checkout", and complete the checkout 

process. 

6. When payment has been processed successfully, an Order Confirmation will be emailed to you 

immediately and you will see the Order Confirmation screen. 

7. Once you have completed your order, click on your username on the top right --> Orders --> 

Downloads 

IMPORTANT: Access to downloadable files will expire 30 days from the order date, so be sure to save a 

copy on your computer. The downloadable file is a PDF document that can be opened using Adobe 

Reader. This material is for your personal use only and is not to be shared or distributed in any form. 

 

Data analysis software 

You will also be required to use several market research tools including Tableau, Excel Analysis ToolPak, 

and GPT in this course. Please follow the instructions below to install the software. 

 

Tableau 

1. Download the latest version of Tableau Desktop and Tableau Prep Builder here 
https://www.tableau.com/tft/activation  

2. Click on the link above and select “Download Tableau Desktop” and “Download Tableau Prep 
Builder”. On the form, enter your school email address for Business E-mail and enter the name 
of your school for Organization. 

3. Activate with your product key:  To be distributed later  
4. Already have a copy of Tableau Desktop installed? Update your license in the application: Help 

menu → Manage Product Keys 

 

Excel Analysis Toolpak 

You must have Excel 2019/2016 for Mac or 2019/2016/2013 for Window. UBC provides access to 

download Microsoft 365 for free (Microsoft 365 includes Excel 2016). Here’s the link: 

https://it.ubc.ca/services/desktop-print-services/software-licensing/office-365-students 

 

Mac Users 

- Click the Tools menu, and then click Excel Add-Ins. 
- In the Add-Ins available box, select the Analysis ToolPak check box, and then click OK. 
- If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it. 

https://www.iveypublishing.ca/s/ivey-coursepack/a1R5c00000FvZroEAF
https://www.iveypublishing.ca/s/ivey-coursepack/a1R5c00000FvZroEAF
https://www.tableau.com/tft/activation
https://www.tableau.com/tft/activation
https://it.ubc.ca/services/desktop-print-services/software-licensing/office-365-students
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- If you get prompted that the Analysis ToolPak is not currently installed on your computer, click 
Yes to install it. 

- Quit and restart Excel. Now the Data Analysis command is available on the Data tab and the 
Tools menu. 

 
Windows Users 

- Click the File tab, and then click Options. 
- Click Add-Ins, and then in the Manage box, select Excel Add-ins. 
- Click Go. In the Add-Ins available box, select the Analysis ToolPak check box, and then click OK. 
- If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it. 
- If you get prompted that the Analysis ToolPak is not currently installed on your computer, click 

Yes to install it. After you load the Analysis ToolPak, the Data Analysis command is available in 
the Analysis group on the Data tab. 

GPT 

- Pls visit https://chatgpt.com/ . Only a free version account is required for this class. 
 

 

NO DISTRIBUTION OF RECORDINGS  
There is no distribution of recordings of class. Classes are designed as and are intended to be in-person. 
Your attendance is expected. If you are unable to attend, the policy regarding missed classes described 
in this syllabus applies. It is your responsibility to ensure that you have the materials you need for 
missed classes.  

COURSE-SPECIFIC POLICIES AND RESOURCES 

Missed or late assignments, and regrading of assessments 
Late submissions will not be accepted and will receive a grade of zero.  
 

Academic Concessions Policy 
Requesting Academic Concessions 
If you experience unanticipated events or other circumstances that constitute valid grounds for 
academic concession as defined by UBC’s Academic Concession Policy, complete and submit the 
Academic Concession Request & Declaration Form. Concessions are time-senstive and the online form 
should be submitted within 48 hours of the missed deadline. Upon submission, your request will be 
recorded in the RHL and you will also receive an email with further insturctions.  Please read this email 
carefully and be sure to also refer to the relevant course syllabus for each concession tht you have 
requested. Please know that you should continue to work on the coursework for the course(s) which 
you submitted a concession fo. You should anticipate being asked to submit work or write an exam as 
soon as the circumstances affecting your ability to fulfil your academic responsibilities are resolved. 

 

Other Course Policies and Resources 
Policies on assessment due prior to students joining the course (i.e., during the add/drop period). 
 

https://chatgpt.com/
https://vancouver.calendar.ubc.ca/campus-wide-policies-and-regulations/academic-concession
https://ubc.ca1.qualtrics.com/jfe/form/SV_81wy4NAsgFHVrFQ
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Code Plagiarism 
Code plagiarism falls under the UBC policy for Academic Misconduct. Students must correctly cite any 
code that has been authored by someone else or by the student themselves for other assignments. 
Cases of "reuse" may include, but are not limited to: 

• the reproduction (copying and pasting) of code with none or minimal reformatting (e.g., changing 

the name of the variables)  

• the translation of an algorithm or a script from a language to another 

• the generation of code by automatic code-generations software 

An “adequate acknowledgement” requires a detailed identification of the (parts of the) code reused and 
a full citation of the original source code that has been reused.  
Students are responsible for ensuring that any work submitted does not constitute plagiarism. Students 
who are in any doubt as to what constitutes plagiarism should consult their instructor before handing in 
any assignments. 

 

POLICIES APPLICABLE TO COURSES IN THE ROBERT H. LEE GRADUATE SCHOOL  

Attendance 
Excepting extenuating circumstances, students are expected to attend 100% of their scheduled class 
hours. Absent students limit their own academic potential, and that of their classmates, and cause 
unnecessary disruption to the learning environment. Students missing more than 20% of the total 
scheduled class hours for a course (including classes held during the add/drop period) without having 
received an academic concession will be withdrawn from that course. Withdrawals, depending on 
timing, could result in a “W” or an “F” standing on the transcript. 
 

Punctuality 
Students are expected to arrive for classes and activities on time and fully prepared to engage. Late 
arrivals may be refused entry at the discretion of the instructor or activity lead. Students arriving later 
than halfway through a scheduled class will be treated as absent for that class. 

 

Electronic Devices 
Devices such as laptops, tablets, and cell phones are not permitted to be used in class unless directed by 
the instructor for in-class activities. Students who do not follow the School’s policy in this regard may be 
required to leave the room for the remainder of the class, so that they do not distract others. Research 
shows that students’ use of laptops in class has negative implications for the learning environment, 
including reducing their own grades and the grades of those sitting around them.  
 

Citation Style 
Please use the American Psychological Association (APA) reference style to cite your sources. 
 
Details of the above policies and other RHL Policies are available at: 
http://www.calendar.ubc.ca/vancouver/index.cfm?tree=12,199,506,1625  

UNIVERSITY POLICIES AND RESOURCES  
UBC provides resources to support student learning and to maintain healthy lifestyles but recognizes 
that sometimes crises arise and so there are additional resources to access including those for survivors 

http://www.calendar.ubc.ca/Vancouver/index.cfm?tree=3,54,111,959
http://www.calendar.ubc.ca/vancouver/index.cfm?tree=12,199,506,1625
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of sexual violence. UBC values respect for the person and ideas of all members of the academic 
community. Harassment and discrimination are not tolerated nor is suppression of academic freedom. 
UBC provides appropriate accommodation for students with disabilities and for religious observances. 
UBC values academic honesty and students are expected to acknowledge the ideas generated by others 
and to uphold the highest academic standards in all of their actions. Details of the policies and how to 
access support are available on the UBC Senate website at https://senate.ubc.ca/policies-resources-
support-student-success. 
 
 

Respect for Equity, Diversity, and Inclusion 
The UBC Sauder School of Business strives to promote an intellectual community that is enhanced by 
diversity along various dimensions including Indigeneity (including identification as First 
Nation, Métis, or Inuit), race, ethnicity, gender identity, sexual orientation, religion, political beliefs, 
social class, and/or disability.  It is critical that students from diverse backgrounds and perspectives be 
valued in and well-served by their courses. Furthermore, the diversity that students bring to the 
classroom should be viewed as a resource, benefit, and source of strength for your learning experience. 
It is expected that all students and members of our community conduct themselves with empathy and 
respect for others.   
 

Academic Integrity 
The academic enterprise is founded on honesty, civility, and integrity. As members of this enterprise, all 
students are expected to know, understand, and follow the codes of conduct regarding academic 
integrity. At the most basic level, this means submitting only original work done by you and 
acknowledging all sources of information or ideas and attributing them to others as required. This also 
means you should not cheat, copy, or mislead others about what is your work. Violations of academic 
integrity (i.e., misconduct) lead to the breakdown of the academic enterprise, and therefore serious 
consequences arise and harsh sanctions are imposed. For example, incidences of plagiarism or cheating 
may result in a mark of zero on the assignment or exam and more serious consequences may apply if 
the matter is referred to the President’s Advisory Committee on Student Discipline. Careful records are 
kept in order to monitor and prevent recurrences.  
 
 
Use of Artificial Intelligence 
 
Generative AI Permitted Where Specified With Attribution 
For this course, students may use generative artificial intelligence (AI), including ChatGPT, for specific 
assessments or coursework, where it is expressly specified by the instructor. In these cases of permitted 
use, students must disclose any use of AI-generated material as per the assessment guidelines. At a 
minimum, this will include proper attribution, including in-text citations, quotations and references. 
Please see your assessment guidelines for full details. 
 
 
COPYRIGHT 

All materials of this course (course handouts, lecture slides, assessments, course readings, etc.) are the 
intellectual property of the instructor or licensed to be used in this course by the copyright owner. 
Redistribution of these materials by any means without permission of the copyright holder(s) 

https://senate.ubc.ca/policies-resources-support-student-success
https://senate.ubc.ca/policies-resources-support-student-success
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constitutes a breach of copyright and may lead to academic discipline and could be subject to legal 
action. Any lecture recordings are for the sole use of the instructor and students enrolled in the class. In 
no case may the lecture recording or part of the recording be used by students for any other purpose, 
either personal or commercial. Further, audio or video recording of classes are not permitted without 
the prior consent of the instructor.  
 
ACKNOWLEDGEMENT 

UBC’s Point Grey Campus is located on the traditional, ancestral, and unceded territory of the 

xwməθkwəy̓əm (Musqueam) people, who for millennia have passed on their culture, history, and 
traditions from one generation to the next on this site.  
 
COURSE SCHEDULE    
(Subject to change with consultation)  
 

 

 

Class   Date  Topic  Readings or Activities  Assessments due  

1   Sep 4 (W) Introduction to Customer Analytics      

2   Sep 6 (F) Customer Lifetime Value   Maru Batting Case    

3   Sep 9 (M) Value of Data   Conquistador Beer   IA 1 due  
 GA 1 in class 

4  Sep 11 (W) Data Visualization I  Software installation  IA 2 due 

5  Sep 16 (M) Data Visualization II  JD.com  GA 2 in class 

6  Sep 18 (W) Market Demand - Linear Regression I  Movie Box Office  

7  Sep 23 (M) Market Demand - Linear Regression II    GA 3 in class 

8  Sep 25 (W) Customer Acquisition and Retention  - 
Logistic Regression 

   GA 4 in class  

9   Oct 2  (W)  Field Experiment and Advertising 
Evaluation 

 StarDigital Case  GA 5 in class  

10  Oct 4 (F) Topics on GPT and class review   

  
  
 


